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1. Introduction 

1.1. Overview 

This workbook will introduce you to the developer tools that help to get Adobe Experience Manager (AEM) 
developers quickly started and working efficiently on projects. Below is a quick overview of how these tools 
typically work together: 
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1.2. Prerequisites 

All steps of this workbook have been pictured with a Mac, but they work similarly on Windows. 
This workbook assumes that following software, or newer, has been installed: 

• Java 7 or 8 
• Adobe Experience Manager 6+ 
• Maven 3+ http://maven.apache.org 
• Eclipse IDE for Java EE Developers https://eclipse.org/downloads/ 
• The AEM extension for Eclipse https://docs.adobe.com/docs/en/dev-tools/aem-eclipse.html 
• Brackets, ideally with Extract http://brackets.io/ 
• The AEM extension for Brackets http://docs.adobe.com/docs/en/dev-tools/sightly-brackets.html 

2. Getting Started 

2.1. Launching in debug mode 

Normally, AEM can simply be started by double-clicking on the JAR file, but to be able to breakpoint it later in 
Eclipse, we will start it in debug mode with the command line. 

‣ Open a Terminal console and navigate to the folder where the quickstart JAR file is located.  
The path shown below depends on the folder where you’ve placed your AEM JAR file: 

cd /Users/username/Desktop/AEM 

‣ Run Adobe Experience Manager in debug mode with the following command line.  
The exact name of the JAR file can vary as well, depending on the version that you have: 

java -jar cq-quickstart-6.1.0.jar -debug 10123 

Starting AEM can take a little over a minute, especially if it’s being launched for the first time, as it is then 
unpacking everything. While it's starting, let’s go to the next step and watch the log file. 

2.2. Log file watching 

The log file is a simple text file, but there’s a special way to open it, because AEM constantly keeps appending 
messages to it, so we want to be able to always see the latest thing that has been appended. 

‣ Open another Terminal window or tab, and navigate again into the folder where the quickstart is located.  
As for launching AEM, the path shown below depends on the folder where your AEM JAR file is located: 

cd /Users/username/Desktop/AEM 
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‣ Keep watching the tail of the log file with following command line to always see what is being appended to it: 

tail -f crx-quickstart/logs/error.log 

AEM is outputting a lot to the log while starting, this will settle once it is done, and page rendering errors will be 
what is most interesting to look after. 

2.3. AEM launched 

Once the instance finished starting, the browser will display a welcome message with a login form. 

‣ Enter the following credential to sign in: 
• User name: admin 
• Password: admin 
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2.4. Creating a new project 

‣ Open the Eclipse IDE 
‣ Switch to the AEM perspective, to have the panels arranged in a convenient way: 

Menu Window –> Open Perspective –> Other… –> AEM –> OK 

 

‣ Click on the new project icon 
 

‣ Select AEM –> AEM Sample Multi-Module Project  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‣ For this lab, use version 10 of the Maven Archetype, 

which is a blueprint used for the project that is 
going to be created. In the future, look out for 
newer archetype versions that will have new 
features included. 

 

‣ Enter the project details: 
• Name:  Summit Lab 
• Group Id: org.summit 
• Artefact Id: lab 

 

‣ Configure the Server: 
• Server name: AEM Development Instance 
• Host name: localhost 
• Port:  4502 
• Username: admin 
• Password: admin 
• Debug Port: 10123 
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It might take a minute for the creation of the project to complete, and when done it should look like below: 

Verify that the project got synchronized to the instance by checking the presence of the Summit Lab site: 
‣ In the left navigation rail, go to Sites 
‣ Navigate to the “Summit Lab Site” page by clicking on its card (located at the bottom of the list) 
‣ On the “English” page click the       pencil icon of its card (displayed when hovering it with the mouse) 
‣ The page you see should look as below: 

‣ In case the “Summit Lab Site” page doesn’t exist, or doesn’t look as above, try a Clean and Publish in Eclipse: 
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3. The Basics 

3.1. The project structure 

As you can see in the Project Explorer pane of Eclipse, the project is split in several sub-projects, which allows a 
good level of separation for the different teams that might work on the project: 

• lab: This is the parent project that contains all the other ones. 
• lab.core: This project contains the OSGi bundles.  

 In MVC terms, it can be considered as the model of the project, or its API. 
• lab.it.*: These two projects contain the integration tests and the corresponding launchers. 
• lab.ui.apps: This contains the components, designs and configurations.  

 In MVC terms, this mostly corresponds to the view. 
• lab.ui.content: This is the content needed for development and testing. Usually, it is a portion of the content 

 from the live production server. 

3.2. The stack 

Understanding the basics of AEM isn’t complicated, but it is a software architecture that is quite different from 
the database architecture that you might be used to. This has profound implications that are important to 
understand well, in order to keep the project simple and elegant. 

The two main pieces of AEM are: 
• Java Content Repository: A hierarchic tree of nodes that basically combines the features of databases (like 

search queries, and structured data) with those of filesystems (like hierarchy, access control, and binary 
data), plus has some additional features (like unstructured data, versioning, and observation). As said, it is 
very different from an RDBMS, most importantly because content is represented with hierarchical nodes. 

• OSGi: A dynamic runtime environment, where Java code and bundles can be loaded, unloaded and 
reconfigured at runtime. 

The way this stack works: 
• Content: All content is persisted as a hierarchical tree of resources in 

JCR, where a resource simply is a node with a specific resource type 
property and other properties to store its content (texts, images, 
references, designs, configurations, …). 

• Components: Referenced from the resource type properties, they 
are located in the JCR as well. They are composed of a dialog, which 
defines the form to edit the resources, and one or multiple 
templates to render the associated resources. 

• Bundles: Running in OSGi, the bundles offer various API that 
correspond to different levels of abstraction of the content. The most 
useful API are standard models of the content, like Resource, or 
Page, but custom bundles can obviously also be built. 
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3.3. Page Rendering 

To understand more concretely how AEM renders a page, let’s breakdown the execution chain for rendering the 
“Hello World!” component highlighted below: 

First, let’s quickly edit the component: 
‣ Click on that “Hello World!” component 
‣ In the toolbar, click the        configure icon 
‣ In the dialog that opens, in the “Text” input field, type “AEM Rocks”, or any text you wish 
‣ Validate the dialog by clicking the checkmark (on the top right) 
Notice how this modified the component, which now additionally shows: “Text property: AEM Rocks”. 

Now to inspect it, let’s first locate that piece of content: 
‣ On the top right, click on the down-arrow next to “Edit” and select “Developer Mode” 
‣ You can now click on any component of the page, editable or not, to understand how the page is built 
‣ Select the “helloworld” component, and click the        view details icon 
‣ This reveals the content path, so click on it: /content/summitlab/en/jcr:content/par/servicecomponent 
‣ This opened in a new browser tab with CRXDE Lite inspecting the content repository at that location 
‣ You now see the resource of that piece of content, which has following properties: 

• jcr:lastModified: The date of the last modification (just a few seconds ago) 
• jcr:lastModifiedBy: The user who did that last modification (you’re logged-in as “admin”) 
• jcr:primaryType: The type of the node itself (can be used to enforce constraints at JCR level) 
• sling:resourceType: A path of the component in charge of rendering that resource 
• text: Contains the value of the text input field that you previously entered  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Each resource with a “sling:resourceType” property can be rendered by AEM. Let’s experiment that: 
‣ Copy the path to that node, which appears in the path field on the top (as shown below) 

‣ Open a new browser window, type “localhost:4502”, paste the copied path, and add “.html”, then hit enter: 

As you see, a page is composed a several resources, which placed together create its full markup. 

Now let’s inspect the component with the template that renders this markup: 
‣ Close the browser tab that we just opened to come back to CRXDE Lite 
‣ In the Properties tab of the “servicecomponent” node, copy the value of the “sling:resourceType” property 
‣ In the path field on the top, type “/apps/”, and paste the copied path, then hit the return key: 

‣ You now see the component with following nodes: 
• cq:dialog: The dialog for the editing the component that you previously used 
• dialog: The dialog for the editing the component in the classic UI 
• helloworld.html: The template in charge to render its HTML output 

‣ Double-click the “helloworld.html” file to open it on the right 

This “helloworld.html” file is a template written in the Sightly template language, which is basically just HTML 
with “data-sly-” attributes and “${…}” expressions that make it dynamic. This is all executed on the server, so the 
rendered HTML that gets to the browser doesn’t contain any of these attributes or expressions anymore. 

The benefit of Sightly templates is that they are very simple to understand, therefore no Java knowledge is 
necessary. Sightly templates also force a clear separation of concerns as they cannot contain any form of code, 
and because Sightly is HTML5, it avoids to mix a template language with the markup, keeping it readable. 

Last but not least, Sightly does state-of-the-art cross-site scripting protection of all variable, automatically 
recognizing the appropriate escaping needed for the HTML context where the variable is located. 
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4. Front-end development 

4.1. Synchronizing edits 

Let’s make our first edit to an AEM component: 
‣ Open Brackets 
‣ From the “File” menu choose “Open Folder…” 
‣ Navigate to the “lab.ui.apps” project and open its “jcr_root" folder, so navigate to following location:  

[Current User] –> Documents –> lab –> ui.apps –> src –> main –> content –> jcr_root 
‣ With the “jcr_root" folder selected, click Open 
‣ In the left rail of Brackets, navigate again to the “helloworld.html” template that we inspected:  

/apps/summitlab/components/content/helloworld/helloworld.html 
‣ On line 16, prepend some text, like “My first component edit!” 
‣ From the “File” menu choose “Save” 
‣ Notice the AEM logo (on the right) that should have turned green to indicate that it successfully synchronized 

all changes to AEM. You can click on it to toggle a panel showing what exactly has been synchronized. 

‣ Now switch back to your browser, open again the “English” page (which should still be in the second tab) 
‣ Refresh the browser window 

You should now see your edit as highlighted below: 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4.2. Using Photoshop Extract 

Brackets has a unique tool to extract information from Photoshop files, like assets, colors, gradients, fonts, 
measurements, or texts. This can make Brackets an exceptional tool to convert designs from Photoshop files to 
HTML designs as it makes it really efficient to write CSS. 

Normally, the Photoshop file should be in a Creative Cloud folder to be accessed by Brackets. But to just quickly 
test that feature, let’s rather use the getting started demo file that is provided by Brackets. 

‣ Open Extract for Brackets by clicking on the       extract icon (on the right) 
‣ In the toolbar of the lower panel that opened, click on the       getting started icon 
‣ Scroll down to the second section of that sample PSD file and click on the green-to-blue gradient box 
‣ In the left sidebar with the project browser, unfold the page component’s “style.css”, located at:  

/apps/summitlab/components/structure/page/clientlib/style.css 
‣ On line 25, append following CSS selector and place the cursor between the two brackets: 

.page__header {  } 

‣ Press the CTRL-Space keyboard shortcut and select the first suggestion to create the same gradient in CSS: 

.page__header { background: linear-gradient(-45deg, #69c8e7 0%, #49d3b4 100%); } 

‣ From the “File” menu choose “Save” 
‣ Switch back to the browser, and refresh the page 

You should now see the page header with an absolutely gorgeous green-to-blue background: 

Also image layers can be easily extracted to your project. The best place to store such files in the content 
repository would be under the “etc/designs” path, which would then also be accessible by the site visitors: 
/etc/designs/summitlab/images 

To spare our eyes, let’s remove again that gradient from the page component’s “style.css” and save the change. 
Before moving on, we can also close the bottom panel of the extract feature, as well as the “style.css” file. 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4.3. Sightly Template Language 

4.3.1. Condition 

In the “helloworld.html” file, see how following line conditionally displays the “text” property of the resource, 
this is the line responsible for previously having shown on the page the message “Text property: AEM Rocks” 
after having set the “text” property in the dialog: 

<p data-sly-test="${properties.text}">Text property: ${properties.text}</p> 

The “data-sly-test” Sightly attribute conditionally displays the element on which it is placed, depending on the 
value of its expression. So if there is a “text” property that exists and that is not empty, it will display the <p> 
element. The content of the <p> element is “Text property: ”, followed by the value of the “text” property. 

4.3.2. Iteration 

To iterate over enumerable variables, like arrays, following Sightly attributes can be used: 
• data-sly-list: Repeats the content of the element for each item of the provided variable 
• data-sly-repeat: Repeats the element itself for each item of the provided variable 

Let’s try this out with a simple list: 

<ul data-sly-list="${properties}"> 
    <li>${item}</li> 
</ul> 

Notice the “item” variable made available within the list, containing the value of each iterated item. 

Sometimes, like when there are nested lists, it can be useful to be able to control the name of the item variable. 
For that, the “data-sly-list” attribute can be appended with a dot, followed by a name for the “item” variable: 

<ul data-sly-list.key="${properties}"> 
    <li>${key}</li> 
</ul> 

And let’s finish enhancing that example with also showing the value of each property: 

<ul data-sly-list.key="${properties}"> 
    <li>${key}: ${properties[key]}</li> 
</ul> 

4.3.3. Logic 

It is sometimes necessary to have component-specific logic, in order to prepare variables for the templates. 
That logic can be either a Java class name, like “org.summit.lab.core.models.HelloWorldModel”, or a server-side 
executed JavaScript file, like “logic.js”. 
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For the start, let’s use the server-side executed JavaScript, and let’s create a “logic.js” file next to the 
“helloworld.html” file. The logic that we will create is to retrieve a page from the Geometrixx sample site: 

use(function() { 
    return pageManager.getPage("/content/geometrixx/en"); 
}); 

To call that logic from our template, there is the “data-sly-use” Sightly attribute, followed by a dot to name the 
variable where the returned result will be available: 

<div data-sly-use.page="logic.js">${page.title}</div> 

As you can see, this is displaying the title of the page located at “/content/geometrixx/en”. 

We can now combine what we have learned, and iterate over the children of that page. For that, you need to 
know that the Page API offers the “listChildren” method: 

<div data-sly-use.page="logic.js"> 
    <ul data-sly-list="${page.listChildren}"> 
        <li>${item.title}</li> 
    </ul> 
</div> 

4.3.4. Remove elements 

Elements that are undesired in the resulting output, but that are needed to host Sightly attributes, can be 
removed by using the <sly> element, let’s use that to remove our outer <div> from the output: 

<sly data-sly-use.page="logic.js"> 
    <ul data-sly-list="${page.listChildren}"> 
        <li>${item.title}</li> 
    </ul> 
</sly> 

4.3.4. Call & Template 

It can sometimes be useful to isolate snippets of Sightly markup as a reusable templates. Let’s try that with our 
list and isolate it as a template. Templates are defined with “data-sly-template” and can be called with “data-sly-
call”. The template definition needs uses the dot notation to define a variable name for it to be called. Finally, 
parameters can be passed using parametric expressions (the “@” is followed by a list of named parameters): 

<sly data-sly-template.childPages="${@ page}"> 
    <ul data-sly-list="${page.listChildren}"> 
        <li>${item.title}</li> 
    </ul> 
</sly> 
<sly data-sly-use.page="logic.js" data-sly-call="${childPages @ page=page}"/> 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A fun thing to do, now that the list is in a template, is that we can call it recursively: 

<sly data-sly-template.childPages="${@ page}"> 
    <ul data-sly-list="${page.listChildren}"> 
        <li> 
            ${item.title} 
            <sly data-sly-call="${childPages @ page=item}"/> 
        </li> 
    </ul> 
</sly> 
<sly data-sly-use.page="logic.js" data-sly-call="${childPages @ page=page}"/> 

4.3.5. More 

Here are two additional Sightly attributes that are important to know: 
• data-sly-include: Includes another Sightly file (or a JSP) 
• data-sly-resource: Includes a specific resource node (a node with a “sling:resourceType” property) 

And Sightly also has several features for the expression language, which are worth exploring. 

Here are some quick examples for future reference: 

<!--/* A Sightly comment that won’t appear in the rendered markup */--> 
Strings and escaping: ${'one'} ${"two"} ${'it\'s great'} 
Arrays:               ${[1, 2, 3]} 
Default values:       ${page.title || 'no title'} 
Internationalize:     ${'assets' @ i18n} ${'assets' @ i18n, locale='en-US'} 
String formatting:    ${'Page {0} of {1}' @ format=[current, total]} 
Not escape HTML:      ${'<p>paragraph</p>' @ context='html'} 
Script expressions:   <script>s.eVar0="${id @ context='scriptString'}";</script> 

The available variables in Sightly templates and in the server-side executed JavaScript are documented here: 
https://docs.adobe.com/docs/en/aem/6-1/develop/sightly/global-objects.html 

The full Sightly documentation is located here: 
https://docs.adobe.com/docs/en/aem/6-1/develop/sightly.html 
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5. Working in Eclipse 

5.1. Editing Components and Bundles 

Let’s start with editing that “HelloWorldModel” that was called from the “helloworld.html” Sightly template: 

‣ In Eclipse, first navigate to the “helloworld.html” file located in: 
lab.ui.apps –> src/main/content/jcr_root –> apps –> summitlab –> components –> content –> helloworld 

‣ See the “data-sly-use” attribute with the java class “org.summit.lab.core.models.HelloWorldModel” 

‣ This tells us where to find the “HelloWorldModel” Java class: 
lab.core –> src/main/java –> org.summit.lab.core.models –> HelloWorldModel.java 

‣ Let’s remove everything related to the “message” variable, and replace that code with retrieving the “text” 
property, setting a default value of “No text”, and changing it to upper case: 

package org.summit.lab.core.models; 
 
import javax.inject.Inject; 
 
import org.apache.sling.api.resource.Resource; 
import org.apache.sling.models.annotations.Default; 
import org.apache.sling.models.annotations.Model; 
 
@Model(adaptables=Resource.class) 
public class HelloWorldModel { 
    @Inject @Default(values = "No text") 
    private String text; 
     
    // This getter exposes data Injected into the Model 
    public String getText() { 
        return text.toUpperCase(); 
    } 
} 

‣ Accordingly, the “helloworld.html” Sightly template can be modified to: 

<p  data-sly-use.hello="org.summit.lab.core.models.HelloWorldModel" 
    data-sly-test="${hello.text}">Text property: ${hello.text}</p> 

‣ Save all changes, switch to the browser, and refresh it. 

Congratulations, you just edited an OSGi Sling Model! 
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5.2. Advanced SlingModel logic 

Let’s now create a more realistic logic that will search the “/etc” structure of the content repository for 
commerce products with specific tags: 

‣ In the Eclipse Project Explorer, right-click on the “org.summit.lab.core.models” package of the 
“HelloWorldModel.java” file and choose: New –> Class 

‣ In the Name field, type “ProductDirectory” and hit “Finish” 

‣ On line 2, above the class body, annotate the class to be a SlingModel that can be adapted from any resource: 

@Model(adaptables=Resource.class) 

‣ From http://bit.ly/product-query, copy the code labelled “1-query-body.java” to line 8, inside the class body. 
This code makes the needed search query and stores the results in a convenient “items” object with a getter: 

private List<Map<String, String>> items = new ArrayList<Map<String, String>>();  
@Inject 
private ResourceResolver resourceResolver; 
@Inject 
private QueryBuilder queryBuilder;  
 
@PostConstruct // This is called after all the injection has occurred  
private void searchProducts() throws RepositoryException {  
    final Map<String, String> map = new HashMap<String, String>();  
    map.put("path", "/etc");  
    map.put("1_property", "cq:commerceType");  
    map.put("1_property.value", "product");  
    map.put("2_property", “cq:tags");  
    map.put("2_property.value", "geometrixx-outdoors:activity/hiking");  
         
    Query query = queryBuilder.createQuery(PredicateGroup.create(map), 
            resourceResolver.adaptTo(Session.class));  
 
    Iterator<Hit> hitIterator = query.getResult().getHits().iterator();  
         
    while (hitIterator.hasNext()) {  
        Hit hit = hitIterator.next();  
        Map<String, String> item = new HashMap<String, String>();  
        item.put("title", hit.getProperties().get("jcr:title", String.class));  
        item.put("image", hit.getProperties().get("image/fileReference", String.class));  
        items.add(item); 
    } 
} 
 
// This getter exposes the work of a @PostConstruct method  
public List<Map<String, String>> getItems() {  
    return items; 
} 
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‣ Also copy the “import” statements of “2-query-import.java”, and replace all the import statements in your 
“ProductDirectory.java” file with them, which should save you some time. 

‣ Finally, in the “helloworld.html” Sightly template, we can use the “ProductDirectory" model, to access its 
“getItems” method simply by doing “products.items”, and iterate over the returned value, displaying it’s 
“image” and “title” properties: 

<ul data-sly-use.product="org.summit.lab.core.models.ProductDirectory" 
    data-sly-list="${product.items}"> 
    <li> 
        <img src="${item.image}" style="width:50px"/> 
        ${item.title} 
    </li> 
</ul> 

The full code for “ProductDirectory.java” and “helloworld.html” can be found at bit.ly/product-query-result. 
Your page should now look something like below: 

As next steps, to take this to the next level, you could edit the dialog of the “helloworld” component, and edit it’s 
“text” input to a “cq:tags” input, where the author can enter the tag of which he wants the products to be listed. 
So in the model, you’d then make the query dynamic. And eventually, you would rename the “helloworld" 
component to something like “product-directory”. 

You now should have a good overview of how some of the most complex components with a reusable Sling 
Model to hold advanced business logic are built. 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5.3. Debugging 

‣ Make sure that AEM was started with the “debug” command line option: 

java -jar cq-quickstart-6.1.0.jar -debug 10123 

‣ In the Servers panel of Eclipse, click the “Connect to server in debug mode” icon 

‣ In a Java file, set a breakpoint by double-clicking in the margin of a code file, for e.g. somewhere in the 
“HelloWorldModel.java”: 

‣ Go to the browser and refresh the page uses this code. 

This will open the debug mode in Eclipse, with the code execution being paused on the corresponding line of 
code for further inspection. 

‣ To resume the execution, click the Resume (F8) button of the toolbar. 

‣ To go back to the previous view in Eclipse, in the “Window” menu, choose Perspective –> Open Perspective  
–> AEM Perspective 

One great feature of the debug mode in Eclipse, is that it also supports hot code replace.  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Congratulations, you completed the lab. 

I hope that you enjoyed it, and that it will equip you with some useful tools and techniques! 


